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1 INTRODUCTION 

This application was originally constructed for the management of client/patient accounts 
for an occupational therapy practice written for MS Access97 and was subsequently 
extended to include physiotherapy. From v 7.x onwards many other practice types are 
catered for. Although based on MSAccess the user does not need to buy Access as the 
necessary runtime files are packaged with this application (hence why the installation 
package is so big). There is no electronic data transfer through EDI and all statements are 
intended to be mailed through the normal snail-mail postal services, or you could email 
them. This application is intended for use by the small practitioner and as you get bigger 
you may find the posting of statements an annoyance and an unacceptable cost. 
All that said the system is well suited to the small practitioner and will enable you to 
manage your accounts yourself; not simply by sending out statements but also by tracking 
who owes what, for how long and how your business is performing in terms of services 
rendered vs income and tax summaries. Facilities to manage locums are also included as 
is basic ICD10 functionality. 
 
Items that are considered important for the success of the system are highlighted 
by a symbol as shown opposite. 

1.1 WHAT’S NEW IN VERSION 7.0 

The main difference is the ability to archive old records. The website lists the incremental 
changes (http://www.krugs.co.za/PumpkinSystems/PumpkinPMS.htm). 

1.2 CONDITIONS OF USE 

You didn’t pay for this product so I don’t promise to support it. I do this for fun in my spare 
time so I’ll assist you where I can. You will, however, need to register with me before using 
it as discussed below – this is just so I know if anybody out there is finding this useful or if I 
really do need to find a life. Feel free to pass it on to your colleagues. Conditions of use, 
hmm, I’d value your feedback – what doesn’t work, what extra features would you like, 
what do you like for that matter.  
Legal stuff…I have no idea. If I’m doing bad stuff I’m sure someone will let me know. 

1.3 REQUIREMENTS 

You will need Access2002/2003 or if you don’t have that then your operating system must 
be at least Windows2000 SP3 or XP in order to use the runtime files that can be 
downloaded from the website. 
 
If you already have Access2002/2003 installed on your machine then you only need the 
installation file called PumpkinPMS705.exe which can be downloaded from 
http://www.krugs.co.za/PumpkinSystems/PumpkinPMS.htm. If you don’t have 
Access2002/2003 installed then you can download the runtime installation file 
Access2003RT.exe from the same website. 
 

http://www.krugs.co.za/PumpkinSystems/PumpkinPMS.htm
http://www.krugs.co.za/PumpkinSystems/PumpkinPMS.htm
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What are runtime files? It’s basically a knocked down version of Access that can be used 
to run an application, but not to design one (as the full version of Access can). Runtime 
files are freely distributable. 
 
Once installed you need at least two .mdb files for the system to work. These are included 
in the installation package PumpkinPMS705.exe:- 
 
1. PumpkinPMS.mdb – this is the front end application that you will be using. It contains 

the forms and reports and whatnot that you see and interact with. There’s no actual 
data in here. 

2. PumpkinPMS_data.mdb – this is where your data actually sits; you don’t see this and 
don’t actually interact with it directly. 

 
In addition to the two files above whenever you wish to install new NHRPL rates (on first 
installation and once a year thereafter) you will need a third file:- 
 
3. NHRPL 2006_04.mdb (or another version of this file) – this contains the NHRPL tariffs 

and new versions can be downloaded from http://www.medicalschemes.com . The 
actual name of the file will change with the newer versions as they are issued by the 
Council. This file contains tariff information for all practice types, but you only need 
those tariffs relevant to your practice. Once your tariffs have been imported into the 
application (explained below), then you no longer need the NHRPL file until the next 
annual tariff review. This file is not included with the installation package as I think I’m 
not allowed to do that, but you can get it from the website mentioned above. Please 
note that you do not have to download this file – the other choice is to type in the 
NHRPL rates manually if you use them. There are more instructions on how to 
download these files on my website. 

 
Note that you can set up whatever tariff structures you like, you’re not restricted to the 
NHRPL (see Section 2.6.6). 
 
And in addition to that… 
 
4. If, after a few years, the application is starting to slow down with all the data in it you 

may wish to archive some of the old stuff.  In this case you will need the file 
PumpkinPMS_archive.mdb which is included in the installation package. 

 

1.4 MS ACCESS BASICS 

Access makes use of tables, queries, forms and reports; there are also macros and 
modules, but they do not concern us here. 
 
Tables: these can be thought of as tables as you would commonly think of them with rows 
and columns. The tables hold the basic, raw data; not calculations that might be derived 
from the raw data. You will, generally speaking, not need to use the tables directly; just be 
aware that this is where your raw data actually sits. An example is shown below. 
 

http://www.medicalschemes.com/
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Figure 1 : Example of a table showing fields and records 

 
Queries: these are questions asked of the data. “Show me information for only client 0367 
(from the table above) or “what clients did I see on 29/4/99?”. Again you will not need to 
use these directly – they are built into the various buttons and whatnot. 
 
Forms: Tables can be rather unfriendly things to enter data to so a form does the job of 
filling in the table or combination of tables, but by means of a more user-friendly front end 
that also makes sure you enter all the required information the correct way. Think of a form 
as you would any paper form.  
 
Reports: A report can be thought of as a document reporting your results. In this case a 
report would be an account statement for a client(s) or a total account history for a client. 
 
So, all the info is entered to tables by filling in a form. You ask questions of the data using 
a query and the result of the query can be printed as a report. 
 
One thing to remember about using Access is that after you type something in a field to 
press <Enter> or <Tab> to move out of that record or click the Refresh button. The act of 
moving out of the record enters the data to that field. Unlike MS Word or Excel you do not 
have to save anything; when you move out of the record the data is saved. 

1.4.1 Navigation in Access 

The picture below shows the navigation buttons seen on the forms and explains their 
functions. Note that record number 15 will not always be record number 15 – it depends on 
how the records are sorted. For instance, in the list “apple”, “banana”, “cherry” the word 
“apple” is the first record, but if you sort the list backwards then “cherry” will be first in the 
list. 
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Figure 2 : Navigation buttons on a form 

1.4.2 Finding and Filtering 

If you wish to find a particular client ID, name, doctor then click in the field of the form you 
wish to search and then click the “Find” button. Type in the text you are looking for in the 
“Find what” field and then click “Find first”. Be careful to pay attention to the other options 
in the dialog box if your search is not yielding the results you expected. Wildcards can be 
used. 
 
Filtering is different from finding in that filtering produces a shortened list that only contains 
records meeting the criteria you specify. Finding does not shorten the list. To filter for client 
“0375” in the Treatment Details form then right click in the Client Ref field, type “0375” in 
the filter criteria box and press <Enter>.  
 
Note that right-click context menus are not available if you do not have the full retail 
version of Access installed on your computer (i.e. if you only have the Access runtime 
installation). In this case make use of the normal menu items. 
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Figure 3 : Filtering for a Client ID 

1.5 SOME CONVENTIONS TO BE AWARE OF 

 Fields with a red label are mandatory (you have to fill them in) 
 Lists with a pink field header indicate that a value below it can be double clicked to 
bring it up in an editable area. 

 The database compacts itself every time it is closed – you may notice a few seconds 
delay when you shut down 

 Labels with ellipsis (…) at the end (e.g. MedAid ID…) indicate that the label can be 
clicked on to activate another form or bring up some other information. 
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2 USING PUMPKIN PMS 

2.1 STARTUP – DEALING WITH THE SECURITY MESSAGES 

When the system first starts you may be prompted by security messages. These should be 
dealt with in the order indicated below: 
 

 

Figure 4 : Dealing with the security messages on startup 

 
Once this has all been dealt with the splash screen (Figure 6) will appear. To prevent 
these security messages from appearing in the future the macro security levels need to be 
set to low as illustrated below. 
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Figure 5 : Setting macro security levels 

 

2.2 REGISTRATION 

When the application opens you will be confronted with the startup splash screen as 
below. The disclaimer just tells you not to blame me if things go awry.  
 

 

Figure 6: Splash screen at startup 

Click “OK” and the Registration form comes up. All fields should be filled in except the 
licence number. Email the information to me by clicking on the “Email” button. I will then 
supply you with a licence number by return mail which you should enter in the space 
provided and click “Register”. You will not be able to get into the application until you have 
entered the licence number. 
Since the application may be used on multiple computers the “Computer Name” field 
serves to identify which machine the licence applies to e.g. “Desktop at home”, “Desktop at 
work”, “My laptop”, “John’s computer” etc. 
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Figure 7: Registration form 

Once you have registered the form will not come up again. The licence number is related 
to the individual computer the application is installed on so if you give a copy to someone 
else they will first need to get a licence number from me. There’s nothing sinister in this, I 
just want to know where the app is traveling to. 
 
Once you have successfully registered you will be faced with the following screen which 
shows the “Main Menu”. The first thing you need to do is set up your personal details 
(banking details, practice name, telephone, address etc) and also import the NHRPL tariffs 
to the database (if you use NHRPL rates). Thereafter we will work through the functions of 
the four tabs on the Main Menu namely Data Input, Statements, Lookup Tables, Tracking 
and Locum. 
 

 

Figure 8 : Main menu 
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2.2.1 Using the Application on Multiple Computers 

You may wish to use the application on your desktop at work, laptop at home and if that 
has a problem maybe your spouses desktop at home too. Since the licence key is tied to a 
specific machine you will need to get a licence key from me for each machine. Once you 
have those licence keys you can move freely between computers. 
 
When you use the application on a new computer for the first time the registration screen 
will come up – fill in the details and email as before. When you receive the licence key 
make sure that you enter it against the correct machine name. 
 
If you do use the application on multiple computers there are three scenarios:- 
1. You install PumpkinPMS from the CD (or download) on each machine. In this case 

you will need to take only one file with you when you move to another machine – the 
data file “PumpkinPMS_data.mdb” and copy it over the existing file at the location 
C:\Program Files\Pumpkin1. 

2. You have installed PumpkinPMS on the other machines you plan to use, but carry 
the data file PumpkinPMS_data.mdb on a memory stick. In this case you will need to 
open the front end on the computer you are using and then tell it where to find the 
data. To do this click Setup>Pumpkin Connect. 

3. You carry both the front end file (PumpkinPMS.mdb) and the data file 
(PumpkinPMS_data.mdb) on a memory stick. In this case you open the front end 
from the memory stick and tell it where to find the data file. To do this click 
Setup>Pumpkin Connect. 

 
See also Section 2.3.1.1. 

                                            
1
 If you cannot see the folder C:\Program Files it may be due to your explorer view settings. Go to Windows 

Explorer and click Tools>Folder options>View and make sure “Show hidden files and folders” is on. 
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2.3 SETUP  

Click the “Setup” button on the Main Menu and fill in the forms shown below. 
 

 

Figure 9 : Personal details and NHRPL setup 

 

2.3.1 Getting the NHRPL Tariffs into the Database 

The NHRPL tariffs come from a database available from the National Council for Medical 
Schemes (http://www.medicalschemes.com). PumpkinPMS is supplied with no tariffs in its 
database, but you should import, from the NHRPL database, only those tariffs relevant to 
your practice type. Here’s the scenario: You are either just starting for the first time or it’s 
some time in the future and the NHRPL database is now out of date and you wish to 
update to the latest price list. There are two choices (i) manually change the rates in the 
“Edit list of tariffs” form which may be somewhat tedious or (ii) import the latest price list as 
described below… 
 
1. Download the latest price list from the website. Lets assume it’s called “NHRPL 

v2006_06.mdb” 
2. Save it in C:\Program Files\Pumpkin (you can delete the old one if you wish – probably 

best to keep it though for “just in case”. 
3. Now PumpkinPMS doesn’t yet know that there’s a new price list in town so you have to 

show it where to find the new rates. 

http://www.medicalschemes.com/
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4. Open PumpkinPMS and go to the Setup form if you’re not already there. Connect to the 
NHRPL database by clicking on the “Connect” button. A file browser will open up. 
Select the NHRPL database and click Open. PumpkinPMS now knows where the 
NHRPL database is. 

 

 

Figure 10: Connecting to the NHRPL database 

5. Pick your practice type and the year edition of the tariffs you want to use. Note that 
some practice types in the NHRPL database do not have any associated tariffs so the 
year edition may be blank. 

6. Click the “Import” button to import only those tariffs relevant to you. 
 

Note: When you import new tariffs then the old tariffs with a code length more than 3 
characters are deleted. This assumes that NHRPL codes are more than 3 characters in 
length and any of your own custom codes are 3 characters or less. Before they are 
deleted, however, they are first copied to a table called tTreatCodes_old just for backup. 

2.3.1.1 Connecting to the Pumpkin Database 

Under normal circumstances you should not need to do this. Normal circumstances would 
be when PumpkinPMS is installed in the default location C:\Program Files\Pumpkin. If you 
have moved the application to some other location then it needs to know where the data is. 
This situation is described further in Section 2.2.1. 
Click on the “Pumpkin Connect” button and browse for the Pumpkin database (a file called 
PumpkinPMS_data.mdb). Select the file and click “Open”. The application now knows 
where to find the data again. 
 



Pumpkin Software 

Page 15 of 39 
  

 

Figure 11 : Connecting to the Pumpkin database 

2.3.2 Banking Details 

The banking details will appear at the bottom of every statement. 

2.3.3 Logo 

The logo, if you have one, will appear on the left hand side; just follow the instructions on 
the form. Choose the “Create from file” option and browse to find your logo. Note that the 
logo must be of .bmp format – and keep it small; 150x150 pixels will do fine. 

2.3.4 My Practice Details 

Click the “My Practice Details” button and fill in those details for your statement headers. 
If you do choose to have a logo you must leave the left hand side text box blank or else the 
text will appear on top of the logo. 
 

2.4 DATA INPUT 

Before starting it is important to remember that each and every modality has two 
important dates viz. TreatDate and StmtDate; the former is the date of a particular 
treatment session or modality and the latter is the date on which the client was 
invoiced for that session/modality. 
 
Before you actually enter any treatment data for a client you need to fill in forms for the 
details of their referring doctor (if required), details of their medical aid and personal 
details. Once this client info is in place you can begin entering their treatment 
sessions/modalities.  
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Fill in any new medical aid or referring doctors first; before doing the clients personal 
details. You only need to enter a doctor or medical aid once and then those details are 
available for every client who needs them. 

2.4.1 Form : Referring Doctor 

The field “DoctorID” is a unique identifier for the doctor. If you ever have two Dr B le 
Roux’s then the first one might be BLER01 and the second one BLER02. This form opens 
on a new, blank record ready for a new entry. Red labels identify fields that must be filled 
in – the rest can be left blank if you wish. The doctors name must be entered in the format 
Surname[comma][space]Firstname. The list at the bottom of the form is not editable, it 
merely provides a quick access list. If you double click on any Doctor ID then that referring 
practitioner will appear in the editable area above.  
 

 

Figure 12 : Referring doctors data entry form 

2.4.2 Form : Medical Aid Details 

A medical aid only needs to be set up once on this form so if you have 10 clients using 
Bestmed it only needs to be entered on this form the first time a Bestmed client signs up. 
If the client is a private patient then enter “Private” in the MedAid field. If you have no idea 
as to the clients medical aid status then create a record with “No details” in the MedAid 
field. It is important not to leave the MedAidID field blank. The full name of the medical aid 
is what appears in the address on the statement.  
If you know that a particular medical aid routinely only pays for, say, 70% of your claim 
then enter “70” in the relevant field in the form. As a result of the medical aid only paying a 
percentage some practitioners have expressed the need to mail two statements. One for 
the full amount to the medical aid (you know they’ll only pay 70% anyway) and one for the 
other 30% directly to the client. Why wait for the medical aid to decline 30% and only then 
send a statement to the client. In order to make this dual statement happen you must enter 
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the percentage of NHRPL rate that the medical aid will pay as discussed above AND you 
must select mail to “Both” on the ClientDetails form. 
 
This form opens on a new, blank record ready for a new entry. Red fields are mandatory. 
 
Double click a medical aid name below the pink label in the list and the form will jump to 
that medical aid in the editing area. 
 
Please note that the medical aid information supplied has not been verified. 
 

 

Figure 13 : Medical aid data entry form 

2.4.3 Form : Client Details 

Use this form to enter the personal details of the client once the medical aid and doctors 
details are in place. This form opens on a new, blank record ready for a new entry. Red 
fields are mandatory. 
 
MedAidID and Doctor ID can be selected from the pick list; just click on the down arrow in 
the box. Once your client has been discharged and all accounts fully paid up then the 
“Active” box can be clicked off and their statements will no longer be printed every month. 
If the client is charged at NHRPL rates click the “Charged at scale of benefits” button on. 
The ClientName must be entered in the format Surname[comma][space]Firstname and the 
PrincipalMember must be entered in the format Title[space]Firstname[space]Surname. If 
the principal member is the same as the client then the client should be entered as 
“Bloggs, Joe” and the principal member as “Mr Joe Bloggs”. If the statement is to be 
mailed to the client then the database uses the principal members name as the addresee. 
The “Comments” field is for your own information only and does not appear on any 
statements. Messages for clients can be printed on the statement and the relevant text 
should be entered in the “Message…” box. There is another utility available when 
statements are being prepared to send the same message to all a particular medical aids 
clients; this will be discussed later. 
Choose the tariff structure that applies to the client: NHRPL, COID, Private rates, 
Discovery or whatever other tariff structures you have defined.. 



Pumpkin Software 

Page 18 of 39 
  

The sub-form at the bottom of the form is “dead” in the sense that no data can be changed 
– it is there for your convenience only so that you can quickly scroll up and down to see 
your list of clients. Double click on any ClientRef below the pink label to jump to that record 
in the editable area. 
If treatment data for this client has been archived then the tickbox in the lower right will 
indicate such. 
 

 

Figure 14 : Client data entry form 

2.4.4 Form : Treatment details 

This form opens on a new, blank record ready for a new entry. Red fields are mandatory.  
 
Use the pick lists to select the ClientRef, TreatCode and Modifier. You may enter either the 
clients reference number or their name – whichever one you use, the other one will 
automatically be filled in. When you pick a ClientRef the last diagnosis for that client 
is automatically filled in – pick a new code from the dropdown list as required. The 
treatment date defaults to the current date, but you may change this as required either by 
typing it in or using the calendar button.  The Description, Base Rate and Factor fields will 
update automatically with the correct tariff structure depending on the treatment code and 
modifier selected. You may still type any value you like in these fields. The comments field 
does not appear on any statements, but may be useful for extra information. Each and 
every treatment session receives a unique ID number, the Treat ID. The Treat ID is 
automatically generated. TreatID is a completely unique reference to a particular treatment 
session and, if deleted, can never be repeated. 
The StmtDate is not entered from this form, but appears just for reference and will 
be dealt with later. If StmtDate is blank it means that the client was never invoiced 
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for this session/modality. 
The default value for Multiplier is 1 if no modifier is selected. Base rate multiplied by the 
Multiplier gives the Debit for the treatment. Debit is calculated automatically. 
If a locum did the work for you then select their name in the locum box – of course you 
must first have entered the locums details in the locum data entry form (see section 2.6.5). 
 
Some practitioners have expressed the need to know exactly which modalities have been 
paid for when the medical aid or client pays up. When a payment comes in you will enter 
the payment as a treatment session using code 1 (Payment by medical aid). The payment 
may cover a number of modalities and you may wish to indicate which ones were covered. 
You can do this by following this procedure: you have just entered the medical aid 
payment as a code 1 so this is the current record. Now, in the “View Client Balance” form 
double click all the TreatDates that the medical aid has paid for and the date will be 
inserted in the description field. 
Should you wish to you can also indicate a particular modality as paid by ticking off the box 
to the right of the modifiers. 
 

 

Figure 15 : Treatment data entry form 

2.4.4.1 Entering ICD Codes 

PumpkinPMS does not come with ICD codes, but space is provided for you to enter the 
ones that you use (see Section 2.6.7). Once the codes have been entered into the lookup 
table then you can use them in Treatment Details as  you wish. To use an ICD code in 
your treatment details click on the        icon. 
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If you click on multiple codes they will all be entered to the “Your current selection” area. 
Click on the big right arrow to submit them to the treatment details form. 
 

 

Figure 16 : Diagnosis (ICD) selection form. 

2.4.4.2 Batch Entry of Treatment Details 

You may find that you frequently use certain groups of modalities and that it is tedious to 
enter them all one by one. To ease this burden the user may define a batch of frequently 
used modalities and submit them all in one go. Setting up of the batch is described in 
Section 2.6.2. Once the batch has been defined then you make use of it as follows. On the 
treatment details form :- 
 
 choose a Client Ref 
 choose a Diagnosis 
 choose a TreatDate and then… 
 
click on the “Batch” button next to the ClientRef and the screen will change to that 
illustrated below. Select the batch you wish to use and click Go. 
 

 

Figure 17 : Using the batch entry method for submission of multiple modalities. 
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2.5 STATEMENTS 

Figure 18 below shows the contents of the Statements tab. 
 

 

Figure 18 : The Statements tab 

These next concepts are important to understand. 
There are 3 “types” of statement:- 

 new 

 previous 

 full history 
New statements are, as the name implies, statements containing never before invoiced 
modalities. “Previous statements” allows you to reproduce a copy of a previously issued 
statement. “Full history” allows you to print the clients entire history. 
Now, how do we know if a client has been invoiced for a particular modality ? When 
a new statement is run and you’re happy that all is correct and you’ve printed it out 
then you must click the “Update : Fill in blank stmt date” button. This will insert the 
statement date for the modalities just invoiced and thus marking them as “invoiced”. A 
blank stmt date against a modality would mean that session had never been invoiced. 

2.5.1 Report : New Statements 

In normal use a statement run will be printed once or twice a month and you will want to 
produce statements for active clients for only those sessions for which they have not 
already been billed. Only active clients are printed because you clearly do not want to print 
statements for clients who were discharged and signed off 2 years ago. If a client has 
already been billed for a session then that session will also not appear on the new 
statements. You can mark a client as inactive even if they still owe you money – perhaps 
you’ve written off their debt. 
Before doing your statement run first get all your data on treatment sessions up to date. 
Now click the “Report : New Statements” button and a menu pops up; . 
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Figure 19 : Client selection for printing of statements 

 
If you wish to print all active clients then click the button “Select all active clients” and a tick 
will appear next to the name of every active client. If you wish to print all active clients 
except 0367 then find his/her name and click the tickbox off. If you wish to print one client 
only then click “Deselect all” to clear all the tickmarks, find the one client you want and 
click their tickbox on. If you wish to print clients from one medical aid only then choose the 
medical aid from the combo box and click the “Select this medical aid >>” button. If you 
wish to add a message to the statement click on the “Messages” button in the top right 
corner. Message centre is detailed further in section 2.5.1.1. 
Enter the statement date  and click “Preview Now !”. If you get a blank statement it will be 
because you have no active clients with new sessions to bill. If all looks in order then print 
your statements. When you close the preview window a box will pop up reminding you to 
update the statement date; this will be dealt with in section 2.5.1.2 below. 

2.5.1.1 Message Center 

Figure 20 below shows the message control center which you can use to add messages to 
your statements. Type your message in the box and depending on who you wish to send 
the message to choose one of the three “Go !” buttons.  
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Figure 20 : Message control center 

 

2.5.1.2 Updating the statement date 

When you close the window a reminder will advise you to not forget to update the 
statement date for the sessions/modalities you have just billed. By doing this you will 
cause the statement date to be automatically filled in to the table for all the sessions you 
have just printed. This is important because it is whether or not this field is blank in 
the table that determines if a session has been billed to the client or not. Only press 
this button after you have printed your accounts and are sure that there are no 
errors. 
When you click the update button the window shown in Figure 21 below will open. The 
same clients that were selected when you printed the statements will still be selected. 
Check that the statement date is what you want and click “Update Now”. If you originally 
only selected one client to print then that same one client will be selected to update. 
I did not make the statement date update at the same time as you print the statements for 
the simple reason that often when the statements are previewed a mistake is discovered 
that you wish to correct. The updating of the statement date should therefore only be done 
when you are happy that there are no mistakes. 
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Figure 21 : Updating the statement date 

2.5.1.3 ICD Codes on the Statements 

The ICD codes appear on each line of the statement, excluding the text description, and a 
summary list appears at the top of the statement which includes the text description. If you 
do not wish for this summary list to appear you can switch it on or off for all clients via the 
Setup screen or for individual clients via the Client Details screen – I think it’s actually 
illegal anyway to show the ICD10 description. An example of what the statement looks like 
with the summary list included is shown below with the ICD codes highlighted. 
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Figure 22 : Example of statement (personal items have been blurred to protect privacy) 

 

2.5.2 Report : Reproduce Previous Statement 

Sometimes you will need to reprint a statement that was issued in the past to a client. So 
long as you know the date on which that statement was produced and the clients reference 
number just click the button and fill in the dialog box. 

2.5.3 Report : Total Account History 

You may, in answer to a query from a client, need to give them a complete account history. 
Click the button and select the clients reference number. If you wish to produce a complete 
history leave the “All” radio button selected. If you wish to produce a history between 
certain dates only then click the “Between dates” radio button; fill in the dates and then 
“Preview Now”. 

2.5.4 E-Mailing Statements 

There are a number of potential ways that this could be done:- 
 

 Exporting the reports (statements) in .snp (snapshot) format. Good quality output, but 
this requires the user to have the full Access installation and the recipient to have a 
Snapshot reader (available free at 
http://www.microsoft.com/downloads/details.aspx?FamilyId=B73DF33F-6D74-423D-
8274-8B7E6313EDFB&displaylang=en). To use this method choose File>Export 

http://www.microsoft.com/downloads/details.aspx?FamilyId=B73DF33F-6D74-423D-8274-8B7E6313EDFB&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyId=B73DF33F-6D74-423D-8274-8B7E6313EDFB&displaylang=en
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when previewing the statements and then attach the resulting file to your email as 
normal. 

 When previewing statements clicking Tools>Office Links will produce an rtf file 
readable in Word or any other package, but the formatting gets messed up a bit. It’s 
readable, but not pretty. The rtf file can also be attached to an email as normal. Also 
a feature only available if you have the full retail version of Access installed. 

 My recommended solution is to create a pdf. You don’t need to buy Adobe Acrobat 
for this, there are a number of free pdf creation tools available on the web such as 
PrimoPDF (www.primopdf.com) or PDFCreator 
(http://sourceforge.net/projects/pdfcreator) or BullZip (http://www.bullzip.com/) 

2.6 LOOKUP TABLES 

Lookup Tables are all about lists of treatment codes, modifiers, hospitals and locums that 
are needed to enter data for treatment modalities. If you wish to change any tariffs on the 
treatment codes, add a new hospital or add a new locum this where you do it. Generally 
speaking once you’re set up and going these items will rarely change – hence they get 
their own tab. 
 

 

Figure 23 : The Lookup Tables tab 

 

2.6.1 Form : Edit list of treatment codes 

When you click this button the following menu appears:- 
 

http://www.primopdf.com/
http://sourceforge.net/projects/pdfcreator
http://www.bullzip.com/
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Figure 24 : Treatment code data entry form 

 
This is where the Treatment Details form gets it’s information from. The NHRPL data was 
imported from the NHRPL database when you set the application up in Section 2.3.1. The 
short description is what appears on the statement and the long description further clarifies 
the short description, but does not appear on the statements. In addition to the normal 
BHF codes (72001 etc) you will need to define some custom codes of your own as the 
need arises. See the sub-form at the bottom of Figure 24 for examples. 
From time to time there may be unusual codes that, when you select them in the 
Treatment Details form, you need prompting about them. If you click the “Use long 
description as warning” box then when you select that code in the Treatment Details form 
the long description will pop up as a warning/notice/prompt. 
Some practices may not use all the treatment codes in the list. Those which you do not 
use may be marked as inactive (i.e. not ticked as Active). Inactive codes will not appear in 
the picklist when entering treatment details. Conversely, only active codes will appear in 
the picklist – so if you don’t see your codes in the picklists it may be because they are not 
ticked off as “Active”. You can use the green tick button and the red cross button to mark 
all treatment codes as “Active” or “Inactive”. 

2.6.2 Form : Batch setup of treatment modalities 

You may find that you frequently use certain groups of modalities and that it is tedious to 
enter them all one by one. To ease this burden the user may define a batch of frequently 
used modalities and submit them all in one go. 
Start by giving the batch a meaningful name that you will recognize later and then add the 
modalities to that batch. Take careful note that each tariff structure has its own rates 
(Discovery is different from NHRPL) so when you set up a batch that batch must be for a 
specific tariff structure. You will therefore need to set up one batch for the NHRPL 
structure and exactly the same one for Discovery.  
 
In terms of giving the batch a meaningful name, therefore, a recommended name would be 
“Spinal1@NHRPL: 72401, 72303/08, 72310/08, 72501” for the NHRPL tariff structure and 
“Spinal1@Discovery: 72401, 72303/08, 72310/08, 72501” for the Discovery tariff structure. 
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“Spinal1” is used in this example because you may have a “Spinal2” for a different batch of 
modalities. Call it whatever you want, you will just need to be able to recognize the name 
when you use it later. 
 
See Section 2.4.4 for guidance on how to apply this feature. 
 

 

2.6.3 Form : Edit list of treatment code modifiers 

The information about the modifiers came from the NHRPL database at setup time 
(Section 2.3.1). The “Factor”, however, is not supplied in the NHRPL database and 
needs to be inserted by yourself. The default value is 1.00. See examples in the 
figure below. 
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Figure 25 : Treatment code modifier form 

2.6.4 Form : Edit list of hospitals 

Not much to say here. 
 

 

Figure 26 : Hospital entry form 

2.6.5 Form : Locums 

If you use a locum or assistant this is where you add their details into the system. There 
are three payment choices: percentage, flat rate or hourly rate. In the example below if you 
click the flat rate radio button then the percentage or hourly rate box will disappear and the 
flat rate box will appear. 
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Figure 27 : Locum data entry form 

You are setting up the default values for a locum in this form. At actual treatment time 
when a locum does the work for you and you enter this information in the Treatment 
Details form you can override these default values and choose whatever you like. 

2.6.6 Form : Tariffs 

Here you enter the rates per treatment code per tariff structure. Each tariff structure is on a 
separate page. Examples of tariff structures are:- 
 NHRPL – the National Health Recommended Price List, the one that most practitioners 
use. This is the one that you can download from the Medical Schemes website. 

 Discovery – Discovery Health does not, currently, agree with the NHRPL rates and has 
drawn up it’s own rates list. PumpkinPMS does not include the rates in this tariff structure, 
but you can enter them yourself if you wish. 

 Private – maybe you charge your own rates for certain, or all, treatment codes. Again, if 
you use private rates then enter the relevant tariffs yourself. 

 COID – Workman’s Compensation – last I heard WorkComp had agreed to go with the 
NHRPL structures, so you actually don’t need a separate COID structure, but if they ever 
started using their own structure again you could put it in here. 

 
Note that for a particular treatment code to be added to a tariff structure it must, of course 
already exist in the database. 
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Figure 28: Tariff data entry form showing the NHRPL structure 

 

 

Figure 29: Tariff data entry form showing the Custom structure 

Figure 29 above shows the Custom tariff structure. The Custom structure contains custom 
codes i.e. codes you (or I) have made up ourselves – the BHF did not make up these 
codes. These codes are used for things like payments, discounts, debt write-off or 
whatever else you care to invent. Although individual codes can be removed from the 
Custom structure you cannot delete the Custom structure itself – let me rephrase, if you do 
find a way to delete the Custom structure – don’t. 

2.6.7 Form : ICD10 Codes 

Enter the ICD10 codes that you use in this list. 
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Figure 30: ICD10 Code data entry form 

2.7 TRACKING 

This section is used to keep a track of how things are going in your business. 
 

 

Figure 31 : The Tracking tab 

2.7.1 Report : View Chart of Debits and Credits per Month 

This report is a simple bar chart showing the value of services rendered and income per 
month and is a simple visual way of tracking your practices performance. An example is 
shown below. A pop-up dialog box will ask for the range of dates you wish to include in 
your chart and whether or not you wish to include archived data. 
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Figure 32 : Bar chart showing value of services rendered and income per month 

2.7.2 Report : Debits and credits per month per treat code 

Produces both a text report and a 3D chart showing the value of the work you are doing 
every month per treatment code. You must select the date range and codes you wish to 
use.  
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Figure 33 : 3D Bar Chart showing the value of services rendered per month per treatment code 

 

Figure 34 : Report showing value of services rendered and income received per month per treatment 
code. 
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2.7.3 Report : Chart of new clients per month 

Produces a bar chart similar to the one above, but shows the number of new clients per 
month. Also offers an option to include archived data (if there is any). 

2.7.4 Report : Outstanding client balances 

When you select this option the following menu will appear:- 
 

 

Figure 35 : Outstanding balances - report options form 

 
Three reports are available form this button:- 
 

 “All clients” : a list of all clients, what they owe, whether they’re active or inactive 
and the date of their last statement (Figure 36) plus some totals. 

 “Active clients only” : as above, but for active clients only 

 “Medical aid summary with account age” : a summary grouped by medical aid 
showing the outstanding balances, the account age and contact telephone numbers 
for the medical aid and the individual (Figure 37). Useful if you’re chasing accounts. 
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Figure 36 : Outstanding balances report 

 

 

Figure 37 : Medical aid summary report 

2.7.5 Report : Tax Summary 

This report provides a simple summary of total value of services rendered and income 
received for the tax years ending February. 
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2.8 LOCUM 

Locum statements can be accessed from this tab. Locums are understood to include 
assistants as well. A social worker, for instance, may make use of an assistant during 
group therapies. When a locum does work for you, you will still enter all the sessions they 
covered into the Treatment Details form, but remembering to select their name(s) as the 
covering locum or assistant (section 2.4.4). This information combined with the payment 
method selected in section 2.6.5 allows statements for the locum to be calculated and 
printed. You print the statement, attach your cheque to the locum and mail it off. 
As for the Statements tab you can print new, previous or full history statements. As 
before remember that after you have printed NEW statements for the locum you 
must insert the statement date. This tells the application that this session has been 
paid out to the locum. 
 

 

Figure 38 : The Locum tab 

 

2.9 UTILITIES 

In normal use this tab would not be used. 
 
If you are testing the functionality of the database you can put in a whole lot of junk data 
and then delete it all in preparation for real use by using the first button. This deletes all 
records in all tables except for Medical Aids and custom Treatment Codes (remember 
custom treatment codes have 3 characters or less). 
 
When you annually import the new NHRPL tariffs/modifiers into PumpkinPMS all the old 
tariffs/modifiers will be copied to a table called “tTreatCodes_old” / 
“tTreatCodeModifiers_old” before they’re cleared out and replaced with the new tariffs. If 
for some reason you want to revert back to your old codes before the import then use the 
appropriate buttons on this tab. To see what’s in the old tables before restoring them just 
click on the “View” buttons. 
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2.9.1 Archiving of Old Data 

A special word about archiving. Archiving is done when you feel that the application is 
slowing down due to the large volume of data. Only treatment details are archived, nothing 
else. When you create an archive any client whose last statement was more than three 
whole tax years ago gets all their treatment details archived. Archiving involves moving the 
data from PumpkinPMS_data.mdb to PumpkinPMS_archive.mdb. In order for this to work 
the system must first know where the archive is. If it’s in the default location (C:\Program 
Files\Pumpkin) then there is no problem, but if it’s somewhere else then you need to tell 
the system where it is. To do this click Setup>Archive Connect. 
You can un-archive old data if you wish (bring the data back) by clicking on the relevant 
button. 

 

Figure 39: The Utilities tab 
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3 SUMMARY GUIDE TO GETTING STARTED 

 

1. Fill in the registration form and email it to me. Enter the licence number when I send it 

back to you. 

2. While you’re waiting for a licence key download the latest NHRPL database (if you use 

these rates). 

3. Fill in your bank details by using Setup. 

4. Connect to the NHRPL database by using Setup (skip this step if you’ve put the 

NHRPL database in the default location C:\Program Files\Pumpkin). 

5. Import the NHRPL tariffs for your practice type. 

6. Fill in your practice details using the Setup>My Practice Details form. 

7. Get your first batch of treatments in order and identify referring doctors, medical aids, 

client details, hospitals and any locums involved. 

8. On the Data Input tab enter any new referring doctors and medical aids if they’re not 

already there. 

9. On the Lookup Tables tab enter any treatment codes, modifiers, hospitals, ICD10 

codes and locums you need (the treatment codes and modifiers will already be there 

and should not need modification unless you want to charge different rates, the 

Modifier Factor will need to be changed by yourself – see Section 2.6.2). Make sure 

that the treatment codes you use are marked as active. 

10. Now fill in the Clients Details on the Data Input tab. 

11. Once all the above is done you can start with the routine of entering treatment details. 

It’s a bit of a schlep to get started having to enter all the setup data, but thereafter it’s 

easy 

 

 

12. Produce your statements monthly from the Statements tab. 

13. Pay your locums through the Locums tab. 

14. Keep a track of how things are going with the Tracking tab. 


